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Formation QGIS 3.x

Journée 5 – 10 décembre

Journée 5

• XYZ et MNT
• Création de données

– Principes de base
– Numérisation Points, Lignes, 

Polygones

• Requêtes
– Par valeur
– Spatiales
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Les sources de données du Z
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Au moins 5 sources de données

Les sources « illustratives » 

1. La carte IGN 
– Courbes de niveau et sommets sont visibles au 5000e

2. Les traces GPX
– Points avec coordonnées XYZ

3. Les « points photos » 
– Points avec coordonnées XYZ

Les sources de données du Z
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Au moins 5 sources de données

Les sources « informatives »

4. Les modèles numériques (MNT / MNS) du Géoportail
5. Le SRTM 

– Shuttle Radar Topography Mission – © NASA
– Résolution de 90 m  30 m
– MNE
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Les sources de données du Z
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Sommet
Courbe

Carte IGN au 5000e

Les sources de données du Z
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Les Modèles Numériques
Il existe trois types de modèles numériques couramment utilisés en 
géomatique : MNT, MNE et MNS.

1. MNT (Modèle Numérique de Terrain)
Représente la surface terrestre nue en 3D, sans aucune végétation, 
bâtiment ou autre structure.

2. MNE (Modèle Numérique d'Élévation)
Similaire au MNT, il représente la surface terrestre nue. Cependant, 
le terme MNE est souvent utilisé de manière plus générale pour inclure 
différents types de modèles numériques représentant l'élévation 
(exemple : MNE « Canopée » : mesure la hauteur de la canopée des forêts).

3. MNS (Modèle Numérique de Surface)
Description : Représente la surface terrestre avec toutes les 
structures présentes, incluant la végétation, les bâtiments et les 
infrastructures.
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Les sources de données du Z
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Vue en estompage de pente (hillshade) du Modèle
Numérique de Terrain (MNT) de la Wallonie issue d’une
acquisition par LIDAR. Il en existe 2 versions :

1. Version 2013 – 2014
• Résolution d’un mètre
• MNT ou MNS

2. Version 2021 – 2022
• Résolution de 50 cm
• MNT ou MNS

Géoportail – MNT « HillShide »
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Les sources de données du Z
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Un Modèle Numérique de Terrain (MNT) et un MNT Hillshade ne renvoient
pas la même altitude car ils représentent des aspects différents du terrain.

– MNT : Il s'agit d'une représentation numérique des altitudes du terrain, où
chaque cellule de la grille représente une valeur d'altitude spécifique.

– MNT Hillshade : Il s'agit d'une représentation visuelle du relief qui simule
l'effet de l'éclairage solaire sur le terrain. Il ne montre pas les valeurs
d'altitude exactes, mais plutôt l'ombre et la lumière projetées sur le
terrain, ce qui donne une impression visuelle de la forme du terrain.

En résumé, le MNT Hillshade est une interprétation visuelle du MNT, utilisée
pour mieux comprendre la forme et les variations du terrain, mais il ne fournit 
pas les valeurs d'altitude précises comme le MNT.

Géoportail – MNT « HillShide »

Les sources de données du Z
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Géoportail – MNT « HillShide »

menu Raster > Extraction > 
Découper un raster selon une 

image de masque
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Les sources de données du Z
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1. Création d’un compte « NASA »
– https://urs.earthdata.nasa.gov/home
– Connexion  [LOG IN]  Profile  Vérification email
– Réception d’un mail de confirmation : GO !

2. Téléchargement de fichiers SRTM 30 m
– https://dwtkns.com/srtm30m/ : connexion
– Altitude exprimée en mètres

« SRTM »

Les sources de données du Z
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« SRTM »
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EXERCICE 1

Ajouter le fichier raster 
« RELIEF_WALLONIE_MNT_2013_2014_HILLSHADE.tif»
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Les sources de données du Z
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Ouvrir le projet « D:/Cartographie/Data/Jour5/Jour5-01/Jour5-01.qgz »

1. Ajouter le fichier « RELIEF_WALLONIE_MNT_2013_2014_HILLSHADE.tif »
localisé sous « D:/Cartographie/Data/Jour5/Raster/MNT RW Liege »

2. Sélectionner la couche > Zoom sur la couche

Géoportail – MNT « HillShide »
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Géoportail – MNT « HillShide »

Propriétés de la couche > Symbologie > Type de rendu

Les sources de données du Z
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Géoportail – MNT « HillShide »
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Les sources de données du Z
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1. Ajouter le fichier « RELIEF_WALLONIE_MNT_1M_2021_2022.tif» localisé
sous « D:/Cartographie/Data/Jour5/Raster/LIEGE_MNT_1M_2021_2022»
Un style est associé automatiquement à cette couche

2. Sélectionner la couche > Zoom sur la couche

Géoportail – MNT 1m 2021-2022

EXERCICE 2

Télécharger et ajouter le fichier raster « N50E005.hgt »
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« SRTM »

https://dwtkns.com/srtm30m/

Les sources de données du Z
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• Dézipper le fichier
• Obtention d’un fichier portant l’extension .hgt



Formation QGIS - Jour 5 28-12-24

(c) JM Michalowski 2024 11

Les sources de données du Z
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1. Masquer la couche «RELIEF_WALLONIE_MNT_2013_2014_HILLSHADE.tif »

2. Ajouter le fichier « RASTER « N50E005.hgt »
3. Sélectionner la couche > Zoom sur la couche

Les sources de données du Z
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3. menu Raster > Extraction > Découper un raster 
selon une image de masque
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Les sources de données du Z
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« SRTM » « RW HillShade »

Les sources de données du Z
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CartoWeb – MNT 1m – SRTM 30m  - « HillShide »
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EXERCICE 3

Générer des courbes de niveau + étiquettes
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Les sources de données du Z
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menu Raster > Extraction > Courbes de niveau

Le nombre de lignes « courbe de niveau » générées est 
lié à la résolution du MNT
– SRMT : 30 m
– MNT « HillShade » : 

1 m ou 0,50 m

Courbes de niveau

Des heures de calcul
4.000.000 lignes !
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Les sources de données du Z
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Courbes de niveau

Intervalle entre les courbes

Attribut « Altitude »

Les sources de données du Z
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Etiquettes Courbes de niveau
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Les sources de données du Z
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Style Courbes de niveau  lignes épaisses pour les centaines de mètres

right( tostring("ALTITUDE"), 2) = '00'

Explication :

• tostring("ALTITUDE") : Convertit la 
valeur entière du champ en chaîne de 
caractères.

• right( ..., 2) : Extrait les deux derniers 
caractères de la chaîne.

• = '00' : Vérifie si les deux derniers 
caractères sont '00'.

EXERCICE 4

Coloriser un MNT
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Les sources de données du Z
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Coloriser le MNT

Couche « Découpé » > Propriétés > Symbologie

Clic droit >  Palette « Spectral »
Inverser la palette de couleurs

EXERCICE 5

Attribuer coordonnée Z à un ponctuel
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Les sources de données du Z
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Ajouter extension « Point Sampling Tool »

Attribuer Z aux points

Les sources de données du Z
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Utilisation de « Point Sampling Tool »

1. Ne permet d’assigner une valeur Z qu’à une couche 
de points visible lors de l’exécution du plugin;

2. Le type géométrique doit être Point; MultiPoint est 
toléré si tous les points sont uniques;

3. La couche de points et le MNT doivent être dans le 
même SCR;

4. Le fichier de sortie est un fichier .GPKG qui peut 
exister; une couche y est créée et ajoutée dans le 
projet courant.

Attribuer Z aux points
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Les sources de données du Z
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Assigner une altitude aux arrêts TEC
1. Ouvrir le signet « Liège Guillemins »  Arrêts TEC visibles
2. Exécuter « Point Sampling Tool »

Attribuer Z aux points

Arrêts de bus

MNT « Découpé »

Nom de l’attribut Z

ALTITUDE

Les sources de données du Z
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Configurer une info-bulle sur la couche créée

Attribuer Z aux points
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Les sources de données du Z
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Arrêts TEC  2 couches
1. « Arrêts de bus » : localisation des poteaux TEC + infos
2. « TEC_Z » : l’altitude des poteaux

Pour « fusionner » les 2 couches, 2 méthodes :
1. Intersection entre les  2 couches  crée une 3e couche
2. Mise à jour via une requête spatiale   voir partie 3

Attribuer Z aux points

Numérisation 
vectorielle

• Précautions d’usage
• Préférences de numérisation
• Aides à la saisie des attributs
• Barres d’outils

– Numérisation de base
– Numérisation avancée

• Créer un point
• Créer un linéaire
• Créer des polygones

– Sans / avec accrochage
– Tracé automatique
– Fusionner des polygones
– Découper des polygones

• Outils de sommet

38Formation QGIS – © JM Michalowski  - IFAPME 2024
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Accès vers les 
vidéos

• Ajout d’un polygone sans accrochage
• Ajout d’un polygone avec accrochage
• Ajout d'un polygone à l'aide de l'option 

"Tracé automatique"
• Tracé automatique d'un polygone 

complexe
• Modifier un polygone en y insérant un 

anneau
• Fusion de polygones
• Diviser un polygone
• Déplacer des nœuds de construction

39Formation QGIS – © JM Michalowski  - IFAPME 2024

Numérisation vectorielle
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Avant de commencer …

1. Réflexion (partagée) sur la modélisation de la 
couche à créer

2. Un type de géométrie (Point/Ligne/Polygone) par 
couche

3. Les objets géométriques ont des attributs
– Un champ identifiant unique (de préférence 

numérique)
– Des champs attributaires

• Liste de valeurs, contraintes, NULL autorisé ?, …

Information
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Numérisation vectorielle
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QGIS n’est pas un logiciel de dessin, mais …

1. Il propose des outils de dessin de base, complétés
par de nombreuses extensions (parfois très
spécifiques)

2. L’import de fichiers type « autocad » est possible
3. Des données peuvent être créés depuis des

adresses postales, des traces GPS, …
4. Bien évaluer les ressources et compétences en

interne, sous-traiter à un bureau de dessin ?

Information

Numérisation vectorielle
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Définir la précision de numérisation : 2 notions

1. Tolérance d’accrochage
– C’est la distance que QGIS utilise pour chercher le sommet

et / ou le segment (ligne) le plus près que vous souhaitez
connecter lorsque vous créez un nouveau sommet ou en
déplacez un existant

– La valeur de la tolérance d’accrochage est utilisée en
CREATION de géométries.

Précision de numérisation
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Numérisation vectorielle
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Définir la précision de numérisation : 2 notions

2. Rayon de recherche
– Le rayon de recherche est la distance que QGIS utilise pour

chercher le sommet le plus proche que vous souhaitez
déplacer quand vous cliquez sur la carte.

– La valeur du rayon de recherche est utilisée en
DEPLACEMENT de géométries.

Précision de numérisation

Numérisation vectorielle
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Précision de numérisation

menu > Préférences > Options > Numérisation
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Numérisation vectorielle
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Précision de numérisation

Projet > Options d’accrochage

Barre outils Accrochage

Numérisation vectorielle
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Intégrité des données
Il est toujours bon de sauvegarder vos données sources avant de 
les éditer. Bien que les auteurs de QGIS aient fait tous les efforts 
possibles pour préserver l’intégrité de vos données, il n’y pas de 
garantie à cet égard.

Sauvegarde des données
Quand une couche est en mode édition, tous les changements
sont stockés en mémoire par QGIS. Ils ne sont pas sauvegardés
immédiatement dans la source de données ou sur le disque.
Si vous voulez enregistrer les modifications sans quitter le mode
d’édition, il faut cliquer sur le bouton

Recommandations
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Numérisation vectorielle
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Les aides à la saisie des attributs

1. Les listes de valeurs  légende catégorisée
2. Les valeurs par défaut

• Valeur numérique ou chaine de caractères
• Attributs géométriques : $area, $length, …
• Expression « Overlay_intersects »

3. Plage de valeurs autorisées (+ barre coulissante)
4. Calendrier pour les champs de type DATE

• Date du jour : expression « now() »

5. Stratégies lors de la duplication ou de la séparation d’une 
entité

Aides à la saisie des attributs

Numérisation vectorielle
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Aides à la saisie des attributs : Liste de valeurs

Projet : Parcellaire forestier
Couche : « Arbres isolés »
Champ : Espèce
Outil : Liste de valeurs

Propriétés de la couche > Mode Formulaire
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Numérisation vectorielle
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Aides à la saisie des attributs : Date du jour

Projet : Parcellaire forestier
Couche : «Voirie»
Champ : DateEntretien
Défauts : Date du jour : now()

Numérisation vectorielle
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Aides à la saisie des attributs : valeur par défaut

Projet : Parcellaire forestier
Couche : « Arbres isolés »
Champ : Etat
Défauts : 1  Sain

Projet : Parcellaire forestier
Couche : « Arbres isolés »
Champ : Parcelle
Défauts : « Overlays_intersects »
• Récupération du numéro de

gestion depuis la couche 
« Parcelles »
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Numérisation vectorielle
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Aides à la saisie des attributs : valeur par défaut

Projet : Parcellaire forestier
Couche : « Parcelles »
Champ : Superficie
Défauts : round($area,2)

Projet : Parcellaire forestier
Couche : « Voirie »
Champ : longueur
Défauts : round($length,0)

Numérisation vectorielle
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Barre d’accrochage

Édition topologique : aide à éditer et à conserver des limites communes entre 
entités.
Gestion du chevauchement

Activer l’accrochage aux intersections

Tracé automatique : créer très rapidement des polygones sur base de lignes 
fermées
Auto-accrochage 

Aide complète numérisation – version 3.34
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Numérisation vectorielle
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Outils de la barre de numérisation de base

• Annuler 
• Refaire 

Numérisation vectorielle
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Fusion de polygones

Le déplacement, l’insertion ou la suppression de nœuds 
de construction se fait depuis la barre de numérisation 
de base (sur la couche active ou toutes les couches !) 

Opérations sur les sommets (nœuds de construction)
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Numérisation vectorielle
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Plusieurs opérations peuvent être réalisées sur les 
sommets (nœuds de construction) :

• Déplacer un sommet : cliquer sur un sommet et cliquer à
nouveau à son nouvel emplacement désiré (la modification ne
sera acceptée que si le déplacement est suffisant important) ;

• Supprimer un sommet : cliquer sur un sommet et puis
appuyer sur la touche [DEL] du clavier ;

• Insérer un sommet : cliquer sur l’un des « + » qui s’affichent
entre deux sommets, et cliquer à nouveau pour définir
l’emplacement du nouveau sommet

Opérations sur les sommets (nœuds de construction)

Numérisation vectorielle
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• Pour se déplacer sur la carte tout en numérisant, on 
peut utiliser les flèches du clavier ou bouger la souris 
en maintenant la molette enfoncée;

• La molette de la souris permet de (dé)zoomer;
• La touche « ESC » annule TOUT le lot de saisies
• La touche « DEL » ou « Backspace » annule la 

dernière saisie;
• Pour abandonner la construction en cours, effectuer 

un clic-droit et cliquer sur annuler dans la fenêtre de 
saisie des attributs qui s’affiche.

Se déplacer dans la carte en numérisant des entités
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EXERCICE 6

Créer des ponctuels et des linéaires
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Numérisation vectorielle
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Création d’un ponctuel « Arbres isolés »

Couche « Arbres isolés »

Ouvrir le projet « Parcellaire forestier » sous D:/Cartographie/Data/Jour5
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Numérisation vectorielle
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Création d’un linéaire « Voirie »

Accrochage

Couche « Voiries »

Numérisation vectorielle
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Création d’un linéaire « Voirie »

Série de « Clics gauche » pour numériser
« Clic droit » pour clôturer 
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EXERCICE 7

Créer des polygones : méthodes de base
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Numérisation vectorielle
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Copier / coller des entités existantes

• L’ajout d’entités peut se faire rapidement en copiant /
collant des entités présentes dans une autre couche
« source » vers une couche cible de même nature
géométrique (Point Point, Ligne Ligne, etc.);

• Si il y a des attributs communs (même nom et même
type) entre les deux couches, les valeurs de la couche
« source » seront copiées vers la couche « cible »;

• Les attributs non-communs de la couche « source »
sont ignorés.
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Numérisation vectorielle
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Création d’un polygone « Parcelle »

Dans notre exemple, la création de limites de nouvelles 
parcelles forestières peut se faire en s’appuyant sur les 
couches « Parcelle », « Coupes » et « Limites de forêt »

Numérisation vectorielle
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Création d’un polygone « Parcelle »
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Numérisation vectorielle
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Création d’un polygone « Parcelle » avec accrochage

Numérisation vectorielle
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Création d’un polygone « Parcelle » avec accrochage
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EXERCICE 8

Créer des polygones : option trace automatique
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Numérisation vectorielle
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Création d’un polygone « Coupes » - Auto- Tracé

• Le mode de traçage automatique, accélère le processus de
numérisation car vous n’avez plus besoin de placer
manuellement tous les sommets pendant la numérisation

• Accrochez-vous à un sommet ou un segment d’une entité que
vous souhaitez tracer.

• Déplacez la souris sur un autre sommet ou segment que vous
souhaitez accrocher, l’élastique de numérisation représente
un chemin entre le dernier point que vous avez accroché et la
position actuelle.
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Numérisation vectorielle
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Création d’un polygone « Coupes » - Auto- Tracé

Objectif : ajouter des polygones à la couche « Coupes »

Etape 1 : définir les options d’accrochage
Etape 2 : tracer la limite du polygone
Etape 3 : « Clic droit » pour terminer le polygone

Cocher les couches sur lesquelles
vont s’appuyer les limites des
polygones à ajouter

Numérisation vectorielle
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Création d’un polygone « Coupes » - Auto- Tracé
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Numérisation vectorielle
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Création d’un polygone « Coupes » - Auto- Tracé

EXERCICE 9

Créer des polygones : Ajouter un anneau
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Numérisation vectorielle
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Création d’un polygone troué : ajout d’un anneau

La création/suppression d’anneaux nécessite l’activation 
de la barre d’outils « numérisation avancée »

Etape 1 : activer la commande « Ajouter un anneau »
Etape 2 : désigner le polygone à trouer
Etape 3 : dessiner l’anneau
Etape 4 : « Clic droit » pour fermer l’anneau et trouer le polygone

Numérisation vectorielle
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Outils de la barre de numérisation avancée
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Numérisation vectorielle
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Création d’un polygone troué : ajout d’un anneau

EXERCICE 10

Créer des polygones : Fusionner des polygones
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Numérisation vectorielle
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Fusion de polygones (couche Parcelles)

La fusion de polygones nécessite l’activation de la barre 
d’outils « numérisation avancée »

Etape 1 : sélectionner les polygones à fusionner (Ctrl + Clic)
Etape 2 : activer la commande de fusion des entités
Etape 3 : définir la stratégie de récupération des attributs
Etape 4 : [OK] pour valider

Numérisation vectorielle
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Fusion de polygones (couche Parcelles)
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EXERCICE 11

Créer des polygones : Diviser des polygones
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Numérisation vectorielle
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Division de polygones (couche Parcelles)

La division de polygones nécessite l’activation de la barre 
d’outils « numérisation avancée »

Etape 1 : activer la commande de séparation des entités
Etape 2 : cliquer les points pour définir la ligne de découpe
Etape 3 : « Clic droit » pour terminer la découpe
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Numérisation vectorielle
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Division de polygones (couche Parcelles)

EXERCICE 12

Déplacer / supprimer des nœuds de construction 
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Numérisation vectorielle
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Déplacement et suppression de nœuds (couche Parcelles) 

Requêtes 
par valeur et 

spatiales

• Analyse spatiale
– Généralités 

• Ajout d’attributs depuis une 
autre couche
– Sélection par localisation
– Relation spatiale 

84Formation QGIS – © JM Michalowski  - IFAPME 2024
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Analyses spatiales

Formation QGIS – © JM Michalowski  - IFAPME 
2024 85

• L’analyse spatiale est le processus de manipulation de
l’information spatiale pour en extraire une nouvelle
information ou l’interprétation des données originelles.

• Un SIG fournit généralement des outils d’analyses spatiales
pour faire des statistiques sur les entités (ex: combien de
sommets forment ce polygone ?) ou des géo-traitements
comme les tampons autour des entités. Les types d’analyses
spatiales varient suivant les sujets d’intérêt.

• Dans QGIS, deux groupes d’outils :
– Outils de recherche (menu Vecteurs > Outils de recherche)
– Outils de géotraitement (menu Vecteurs > Outils de géotraitement)

• Sans compter la « Boite à outils » !

Analyses spatiales
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La création de tampon (« buffer ») est un outil d’analyse
spatiale important et souvent utilisé mais il en existe d’autres.

Le recouvrement spatial est un processus qui permet
d’identifier les relations entre deux entités de polygone qui
partagent leur surface ou une partie de cette surface ensemble.
La couche vecteur qui en résulte est une combinaison des
informations des entités d’entrée.
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Analyses spatiales
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• Intersection : La couche de sortie contient toutes les surfaces qui
recouvrent les deux couches (intersection).

• Union : La couche de sortie contient toutes les surfaces combinées des
deux couches vecteurs.

• Différence symétrique : La couche de sortie contient toutes les surfaces
des couches d’entrées sauf les surfaces où les deux couches se
recouvrent (intersection).

• Différence : La couche de sortie contient toutes les surfaces de la
première couche d’entrée qui ne recouvrent pas (intersection) la seconde
couche

Les relations spatiales
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On utilise une relation spatiale entre les objets
géographiques pour obtenir les informations d’une
couche source et les ajouter à la couche cible.

Une relation spatiale peut être, par exemple, l’intersection, la
contenance, le point le plus proche, etc.

On ouvre la Calculatrice de champ depuis la table d’attributs ou 
via un clic droit sur la couche cible pour insérer la relation 
spatiale (Catégorie Géométries) et la paramétrer.
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Les relations spatiales
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Les fonctions overlay_* disponibles sont :

– overlay_contains: Cette fonction vérifie si une entité géographique contient
complètement une autre entité géographique.

– overlay_crosses: Cette fonction vérifie si une entité géographique croise une
autre entité géographique.

– overlay_disjoint: Cette fonction vérifie si deux entités géographiques ne se
touchent pas du tout.

– overlay_equals: Cette fonction vérifie si deux entités géographiques sont
identiques.

– overlay_intersects: Cette fonction vérifie si deux entités géographiques se
chevauchent.

– overlay_nearest: Cette fonction trouve l'entité géographique la plus proche
d'une autre entité géographique.

– overlay_touches: Cette fonction vérifie si deux entités géographiques se
touchent sans se croiser.

– overlay_within: Cette fonction vérifie si une entité géographique est
entièrement contenue dans une autre entité géographique.

Les relations spatiales
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Les fonctions overlay_* sont disponibles depuis la catégorie Géométrie
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Les relations spatiales
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La fonction « overlay_* » retourne un tableau de
valeurs ([array]) :

[Valeur 1]
[Valeur 2]
[Valeur 3]

Pour convertir le tableau en une chaine de caractères, 
on utilise la fonction « array_to_string( ) » 

Valeur 1, Valeur 2, Valeur 3

Champ virtuel : avantages
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Efficacité de stockage : Les champs virtuels ne consomment pas de
stockage physique car ils sont calculés à la volée lors de l'accès aux données.
Cela permet de garder votre base de données légère.

Flexibilité : Vous pouvez créer des champs basés sur des calculs ou des
expressions complexes sans modifier les données originales. Cela permet de
générer des informations supplémentaires sans altérer la couche de données.

Mises à jour automatiques : Les champs virtuels se mettent à jour
automatiquement si les données sous-jacentes changent. Cela assure que les
informations restent toujours à jour sans nécessiter de recalcul manuel.

La définition des champs virtuels est stockée dans le projet
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EXERCICE 13

Associer un champ d’une couche de Points à une
couche de Polygones qui l’intersecte
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Mise à jour Polygone depuis Point
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Objectif : ajouter à la couche « Parcelles cadastrales
Mairie » (Polygones), le champ « Photo » de la couche
« Mairies » (Points)

Etape 1 : Ajouter un champ virtuel
Etape 2 : Mette à jour ce champ via la relation spatiale 

« overlay_intersects »

array_to_string(overlay_intersects('Mairies', Path))

Etape 3 : Configurer Formulaire pour afficher le lien vers la pièce jointe 
(optionnelle)

Ouvrir le projet « Jour5-01 » sous D:/Cartographie/Data/Jour5
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overlay_intersects
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Mise à jour Polygone depuis Point
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Couche cible : Parcelles cadastrales Mairies
Couche source : Mairies
Champ à ajouter : Path 

array_to_string(overlay_intersects('Mairies', Path))
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Mise à jour Polygone depuis Point
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Deux parcelles sans photo.  Pourquoi ?

Mise à jour Polygone depuis Point
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La parcelle n’intersecte pas le Point “Mairies”  déplacer le point
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Mise à jour Polygone depuis Point
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Après déplacement du point, la parcelle est mise à jour automatiquement

Mise à jour Polygone depuis Point
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Sauver le projet pour conserver l’ajout du champ « Photo »

Editer la relation spatiale
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EXERCICE 14

Associer un champ d’une couche de Points à une
couche de Points qui l’intersecte
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Mise à jour Point depuis Point
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Objectif : ajouter à la couche « Arrêts TEC », le champ
« ALTITUDE » de la couche « TEC_Z » (Points)

Etape 1 : Ajouter un champ virtuel
Etape 2 : Mette à jour ce champ via la relation spatiale 

« overlay_intersects »

array_to_string(overlay_intersects('TEC_Z', ALTITUDE))
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Mise à jour Point depuis Point
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array_to_string(overlay_intersects('TEC_Z', ALTITUDE))

EXERCICE 15

Associer un champ d’une couche de Polygones à une
couche de Polygones qui l’intersecte
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Mise à jour Polygone depuis Polygone
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Objectif : ajouter à la couche « Parcelles cadastrales »
(Polygones), le champ « Nom de quartier » de la
couche « Quartiers » (Polygones)

Etape 1 : Ajouter un champ virtuel
Etape 2 : Mette à jour ce champ via la relation spatiale 
« overlay_intersects »

array_to_string(overlay_intersects('Quartiers', Nom))

Mise à jour Polygone depuis Polygone
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array_to_string(overlay_intersects('Quartiers', Nom))
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Mise à jour Polygone depuis Polygone
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EXERCICE 16

Analyse par plus proche voisin

Formation QGIS – © JM Michalowski  - IFAPME 2024 108



Formation QGIS - Jour 5 28-12-24

(c) JM Michalowski 2024 55

Analyse par plus proche voisin
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Objectif : Trouver les 5 arrêts de bus (couche Arrêts
TEC) les plus proches des parcs urbains de la ville de
Liège (couche Espaces verts)

menu >Traitements > Boite à Outils 

Analyse par plus proche voisin
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Couche d'entrée : Couche de points ou de polygones dont on
souhaite joindre les entités les plus proches.

Couche jointe : Couche de points ou de polygones par rapport à
laquelle on souhaite trouver les entités les plus proches

Champs à copier de la couche jointe vers la couche d’entrée

Nombre maximum de correspondances les plus proches à
rechercher pour chaque entité de la couche d'entrée.

Rayon de recherche maximal pour trouver les correspondances. 
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Analyse par plus proche voisin
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EXERCICE 17

Ajouter le nom de voirie aux bâtiments
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Ajouter le nom de voirie au bâti
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Objectif : ajouter aux bâtiments (couche Bâtiments
cadastraux) du quartier « Guillemins » le nom de voirie
(couche Voirie) le plus proche (overlay_nearest) du bâti

Etape 1 : sélection du quartier « Guillemins »
Etape 2 : sélection des bâtiments inclus dans ce quartier
Etape 3 : ajouter le nom de voirie aux bâtiments

array_to_string(overlay_nearest(layer:='Voirie’,expression:= name, 
max_distance:= 25, limit:=1))

Ajouter le nom de voirie au bâti
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Sélection du quartier « Guillemins »
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Ajouter le nom de voirie au bâti
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Sélection des bâtiments du quartier « Guillemins »

Ajouter le nom de voirie au bâti
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Mise à jour de la couche Bâtiments

max_distance : distance optionnelle pour limiter la
recherche d’entités correspondantes. Si cette distance
n’est pas définie, toutes les entités de la couche cible
seront utilisées.
limit : nombre entier optionnel pour limiter le nombre
d’entités correspondantes. S’il n’est pas défini, seule
l’entité la plus proche sera retournée.
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Ajouter le nom de voirie au bâti
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Résultat pour les 975 bâtiments sélectionnés

Ajouter le nom de voirie au bâti
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Infobulle sur les bâtiments

Case … When … Else … End

WHEN "Voirie" IS NOT NULL AND "Voirie" != '' : Vérifie si
Voirie n'est pas nulle et n'est pas une chaîne vide.

THEN 'Bâtiment situé en bordure de la ' || "Voirie" :
Valeur de retour si la condition ci-dessus est vraie.

ELSE 'Pas de voirie définie' : Par défaut, si Voirie est une
chaîne vide mais pas null, la valeur de retour est "Pas de
voirie définie".
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Ajouter le nom de voirie au bâti
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La mise à jour en une seule étape !

CASE
WHEN overlay_within('Quartiers', 

filter:="Nom" = 'Guillemins') 
THEN

array_to_string(
overlay_nearest(

layer:='Voirie', 
expression:= name, 
max_distance:= 25, 
limit:= 1

)
)

END

EXERCICE 18

Masquer des étiquettes par filtre géographique
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Masquer des étiquettes par filtre géographique
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Objectif : masquer les étiquettes d’une couche en 
fonction d’un critère géographique
• Couche à étiqueter : Provinces  étiquettes sur Provinces 

wallonnes via le champ « NameFRE »
• Couche de filtre géographique : Flandre-BXL (couche privée)

CASE 
WHEN overlay_within('Flandre-BXL') is 'false' 
THEN "NameFRE" 

ELSE '' 
END

CASE 
WHEN overlay_within('Flandre-BXL') is 'false' 
THEN "NameFRE" 

ELSE “NameDUT” 
END

Masquer des étiquettes par filtre géographique
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Masquer des étiquettes par filtre géographique
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